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INTRODUCTION

WHAT ARE THE FOUNDATIONS OF 
DIGITAL ART AND DESIGN?
In the School of Arts, Technology, and Emerging Communication (ATEC) at UT 
Dallas, where I am teaching now, students encounter this book during their 
first year of coursework. However, knowing the origin story of this book is 
useful for understanding how I came to think about foundations materials for 
digital art and design students who might be completing coursework in vari-
ous types of schools or programs, such as art, communication, design, digital 
humanities, media studies, and so on.

I originally designed this book before arriving at UT Dallas, when most of my 
students had little time in their schedules for classes that would heighten their 
understanding of visual communication: foundations of two-dimensional 
design, typography, drawing, and so on. Instead, they enrolled in a large 
historical survey course and some took an elective “skills” course, in which 
they learned some Adobe applications. Mastery doesn’t happen in a mere 
sixteen weeks. At best, the skills course created awareness of the concepts 
and techniques that someone entering the creative professional industries 
should master.

First developed to serve these students, this book is now used by readers 
and educators in two-year and four-year fine arts and applied arts programs, 
college-level communications and media departments, and in some U.S. high 
schools. Knowing the breadth of my audience, the aim of this book is to offer 
the most information at the confluence of design (principles, histories, and 
theories), Adobe software, and examples of digital art for readers, educators, 
and practitioners with varied interests. My goal is to be thorough enough for 
university students and clear enough for high school students.

The majority of my students are interested in practicing the exercises and 
mastering the software, because they’re anxious to jump in and create. Educa-
tors are interested in teaching art and design, because they’re passionate 
not about software, but about media art, graphic design, animation, games, 
digital video, emerging forms of digital expression, and so on.

My approach to mediating this clash of interests is to write about and show 
as many ideas and examples of art and design history and principles as I can 
while demonstrating the use of the tools. For example, instead of showing 
students how to remove red-eye from a photograph (there are loads of videos 
on YouTube for such a specific endeavor), I demonstrate making a conscious 

Introduction  xi



design choice in regard to scale, proximity, the rule of thirds, or other prin-
ciples while using Adobe’s tools. I’ve tried to keep the exercises short, while 
also showing the fundamental tools in many of the Adobe programs. Most of 
the tools have changed very little since the first time I used Photoshop in 1992 
(with the major exception of the development of layers in 1994, but I digress).

In ATEC, students attend a lecture, traditional studio, and computer lab. So 
this course (and this book) merges a traditional course in two-dimensional 
design with foundations of digital art and design practices. I start in Sec-
tion 1, Bits, Pixels, Vectors, and Design, with material that’s been presented by 
the authors and artists on whose shoulders I’m crouching: Donis A. Dondis 
(A Primer of Visual Literacy), Johannes Itten (Design and Form: The Basic 
Course at the Bauhaus and Later), David A. Lauer and Stephen Pentak (Design 
Basics), Wucius Wong (Principles of Form and Design), and others. It is this 
understanding of the language of design that I consider foundational. I also 
include examples of each principle or basic element drawn from contempo-
rary works of digital art. Although this book may be assigned in a graphic 
design program, it’s often read within the broader context of digital art. I have 
had many roles as an educator, from an education advisor on the AIGA Orange 
County board to a co-author of a trilogy of collections on remix studies—my 
personal identity as a digital artist is also part of this equation.

Two-dimensional design is followed by Section 2, Digital Photography. In the 
classroom, I find it easier to present basic vector graphics before introducing 
the pixel-loaded arena of digital imaging—Adobe Illustrator is often a much 
more forgiving application than Adobe Photoshop due to the insignificance 
of file resolution at such a basic level. In this text, photography is primarily 
considered to be another vehicle through which the basic elements of design 
can be understood. In our program, students use this portion of the text to 
learn to organize files, compose in a photographic frame, and understand 
color relationships.

Because photo manipulation is nearly as old as the medium itself, the natural 
follow-up to photography is Section 3, Digital Manipulation and  Fair 
Use—where better to talk about contrast through juxtaposition? Collage and 
photomontage are historical legacies of the digital operations: cut, copy, and 
paste. While discussing these, I also bring forth contemporary strategies for 
sampling and licensing with copy-left or Creative Commons licenses in this 
section.

Section 4, Typography, teaches students to honor and manipulate type. This 
is essential, as most visual communication comprises type and image, and 
occasionally time. I studied photography in my undergraduate days at the Art 
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Institute of Boston; typography is an art that I learned during my professional 
life as a web designer in the 1990s and since then as a professor. It helped that 
I lived with one of the best typographic educators in Southern California in 
the early 2000s. I’ve talked with many educators who are strong in one area—
photography, typography, web design, or something else—but feel a deficit 
in another. As such, I provide resources for additional materials throughout 
the book, both for students and educators who might be using this text in 
a classroom.

The Coda, at the end of the book, explains the important concept of revision. 
A student may assume that she has an experiential understanding of design 
principles after simply following the steps in a software application. Students 
and readers must remember, however, that reading a book on learning to play 
the guitar or manipulate imagery, is not the same as mastering the instru-
ment or software. Practice, and of course revision, is the best way to learn the 
craft and become more efficient. I’ve included revision stories from artists and 
design professionals alike.

In addition, you’ll find one bonus section online or in the electronic version of 
this book:

Automation is key to working efficiently, so one chapter in Section 5, Effective 
Work Habits, (available online or in the eBook) is dedicated to it. The other 
chapter addresses the question, “How do you suggest I make a portfolio I can 
send someone?” There’s no one perfect answer, as each student has different 
talents and different needs. But learning pagination in Adobe InDesign can 
help students who want to create their own books—a handy skill for soon-to-
be graduates or those applying for internships.

Lastly, I would like to offer an update of Dondis’s scale that registers the 
differences (or similarities) among specific artistic media on a continuum of 
“fine” and “applied” art in FIGURE I.1. To demonstrate that the Bauhaus “would 
group any and all of the fine and applied arts on one central point in the 
continuum” [1], Dondis placed the media of the time grouped around a central 
point on the horizontal axis (FIGURE I.1).

All forms of visual message-making are influenced and analyzed by an 
understanding of the basic elements of design, on the screen, in print, as a 
hologram, or however else they may come to us on future platforms. Whether 
you intend to be a web designer, a social media entrepreneur, a digital instal-
lation artist, or a game developer, the design foundations offered in this book, 
coupled with the exercises in each of the software applications, will help you 
achieve your goals.

REFERENCE [1]  Donis A. 
Dondis, Primer of Visual 
Literacy (Cambridge, MA: 
MIT Press, 1973). 4.
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Because all students or readers will have different hardware, software, and 
needs, you’ll learn to use this book in the most fitting way for your setup in 
the following exercises.

FIGURE I.1  Donis A. Dondis 
developed the original illus-
tration in reference to the 
perceived intellectual divide 
between the two purposes, 
outcomes, or beliefs about 
art making. (The image is 
essentially the same, where 
the labels would have been 
the text appears here with a 
strike through it.)

xiv  FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD



EXERCISE 

1 OPERATING SYSTEMS

When the Mac was released in 1984, it included a graphical user interface 
and a mouse, two visual user-oriented components that were missing from 
other personal computers (FIGURE I.2). Artists and designers developed a strong 
loyalty to Apple over time as their needs and concerns were often met first on 
the Apple platform. For a while, there was no question about which plat-
form was best suited to making art on the computer: Mac. Universities now 
have Mac and Windows labs dedicated to art and design programs. In some 
creative industries, such as graphic design or digital photography, Mac (now 
rebranded macOS) is still the standard platform. However, web designers, 
game developers, and animators often work on the Windows platform.

It does not matter if you use a macOS or Windows. Your files will transfer eas-
ily from one operating system to the other. (Be sure to include the file exten-
sions in the name of your file—something you’ll learn more about in Chapter 1, 
The Dot, the Path, and the Pixel). If you’re creating multimedia art or designs, 
you’ll want to view the work on both platforms. However, this should not 
dictate where you conceive and develop the project.

I’ve written this book using macOS. The screenshots were made on my Mac-
Book Pro. However, every keyboard shortcut is provided in both macOS and 
Windows versions. For instance, the File > Copy command shortcut is listed 
throughout the book as Command-C/Ctrl-C.

That’s it. The rest is more or less the same.

EXERCISE 

2 DOWNLOADING WORK FILES, BONUS 
CHAPTERS, AND VIEWING SCREENCASTS

Some of the exercises in this book will require you to download a work file or 
a set of files before you begin. Readers who buy the print edition of the book 
will also want to download the bonus section on Effective Work Habits. All of 
the files are on the companion websites for the book at www.digitalart-design.
com (FIGURE I.3) and at peachpit.com for registered users (see “Accessing the 
online content at peachpit.com” later in this chapter). I’ve also posted a link 
to the work files on my personal website (www.missconceptions.net), and 
there’s a Facebook page for Foundations of Digital Art and Design where I post 
updates and answer reader questions [2]. 

REFERENCE [2]   
facebook.com/ 
FoundationsOfDigital 
ArtAndDesign

FIGURE I.2  The first Mac 
computer sold commer-
cially in 1984. It included  
a mouse and a graphical 
user interface instead of  
the ever-intimidating  
command line.
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Most chapters include a screencast in which I have demonstrated my process 
for some part of the chapter’s exercises. These offer me an opportunity to 
show a portion of the exercise that is better demonstrated in a live presenta-
tion than captured in images and text. They are also an archive of tutorial  
files that my students and I rely on for use outside of the classroom. These  
are accessible from the companion website. The screencasts for this second  
edition of the book are published on Vimeo [3]. The screencasts for the  
first edition of the book are preserved on YouTube [4].

ACCESSING THE ONLINE CONTENT 
AT PEACHPIT.COM
1.	 Go to www.peachpit.com/register.

2.	 Sign in or create a new account.

3.	 Enter the ISBN: 9780135732359, and click Submit.

The lesson files can be accessed through the Registered Products tab on 
your Account page. Click the Access Bonus Content link below the title of 
your product to proceed to the download page. Click the lesson file links to 
download them to your computer.

FIGURE I.3  A screenshot of 
the companion website, 
www.digitalart-design.
com. You can download any 
necessary work files from 
this site before beginning to 
work on the exercises in the 
chapters.

REFERENCE [3]   
bit.ly/video-demos or  
bit.ly/foundations-demos

REFERENCE [4]   
bit.ly/youtube-demos
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EXERCISE 

3 THIRD-PARTY IMAGES

Many of the images in this book were donated by artists and designers. 
Some were available for me to use in a commercial publication because 
the copyright had expired or because the work was part of a government 
archive, which usually puts it into the public domain. To those who donated: 
Thank you!

You’ll learn more about public domain, the copyleft movement and creative 
licensing techniques in the introduction to Section 3, Digital Manipulation and 

 Fair Use.
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THE EXERCISES IN this chapter will provide technical lessons using 

Adobe Photoshop and Adobe Lightroom Classic and teach you to 

match textures and values to create photographic illusions in two 

compositions. You’ll explore various tools for healing and cloning 

parts of an image, as well as add a simple layer mask to blend image 

features for a quality of verisimilitude.

REPAIRS AND HOAXES
CHAPTER 7

145



DIGITAL REPAIRS
The repair tools are stacked in a series in the Photoshop Tools panel, starting 
with the Spot Healing Brush tool beneath the Eye Dropper tool. The tools I 
use most often to make repairs are the Spot Healing Brush tool and the Clone 
Stamp tool. The Patch tool can be hard to control or predict, and the Red Eye 
tool does what you think it does. (It’s certainly useful.)

The Spot Healing Brush tool functions as a fix-it paintbrush. You simply click 
any part of the image, and the brush attempts to repair (or correct uneven 
tones in) the area based on a sample of nearby pixels. Of course, it’s never a 
good idea to modify your original image. So when using these tools, I recom-
mend copying the background layer to preserve the original file. You’ll learn 
more about non-destructive editing in Chapter 8, Select, Copy, Paste, Collage.

The Clone Stamp tool is also a brush. Cloning is a two-step operation: Photo
shop needs to understand what you’re cloning and where the clone should 
be applied. So you’ll need to sample an original source (the what part of the 
question) and then brush the sample into a new location (the where part). The 
sampling part of the Clone Stamp operation can sometimes be tricky to learn, 
but once you master the tool you’ll be able to repair just about anything.

Before Photoshop, artists manipulated images during the photo shoot, in the 
darkroom, or on the print, for instance, with SpotTone, a specialty ink used 
to correct or fill in white areas of photographs for dust spots. This seems like 
a lost art now that basic photo repairs can be made so quickly using software. 
However, manipulating photographic imagery has ethical implications for 
photojournalists and media contributors in the digital age. For instance, the 
National Press Photographers Association (NPPA) Code of Ethics includes the 
following statement:

“Editing should maintain the integrity of the photographic images’ content 
and context. Do not manipulate images or add or alter sound in any way that 
can mislead viewers or misrepresent subjects” [1].

Instances of photo manipulation to “get a better shot” have led to firings (for 
instance, Bryan Patrick from the Sacramento Bee) and loss of credibility (the 
infamous National Geographic cover of the Egyptian pyramids in 1982 where 
a horizontal image was smooshed into a vertical cover space). They’ve also 
led to increased criticism within the field. Take a look at two shots of O. J. 
Simpson published in June 1994 by Newsweek and Time magazines: the Time 
photograph was manipulated to make Simpson’s skin appear darker than it 
actually is.

LINK  For more informa-
tion on the repair tools in 
Photoshop, see the Adobe 
Photoshop help page: helpx.
adobe.com/photoshop/
using/retouching-repairing-
images.html.

HEALING BRUSH  This 
tool is essentially a 
combination of the Spot 
Healing Brush tool and 
the Clone Stamp tool: It 
lets you sample a source 
and tries to even out 
adjacent tones and blem-
ishes based on nearby 
pixel information.

REFERENCE [1]   
See nppa.org/code-ethics.

You can see both images 
of O. J. Simpson on the 
cover of the two maga-
zines side by side in the 
entry “O. J. Simpson 
murder case” on 
Wikipedia.
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WHAT IS ETHICAL IN REGARDS TO DIGITAL MANIPULATION?

In the “Changes to Photographs” section of the NPPA Special Report: Ethics in the Age 
of Digital Photography, Rev. Don Doll, S.J. is credited for the following ideas: “There 
are technical changes that deal only with the aspects of photography that make the 
photo more readable, such as a little dodging and burning, global color correction, 
and contrast control. These are all part of the grammar of photography, just as there 
is a grammar associated with words (sentence structure, capital letters, paragraphs) 
that make it possible to read a story, so there is a grammar of photography that 
allows us to read a photograph. These changes (like their darkroom counterparts) 
are neither ethical nor unethical—they are merely technical.” (See www.nppa.org/
node/5127 for more information.)

CREATING A HOAX
Although visual reporters need to handle digital manipulations with caution 
and care, artists often use these tools to create commentary on popular media 
and historic subject matter. For instance, Josh Azzarella’s still and video 
works use manipulation to revise historic events by way of deletion. In his still 
image, Untitled #15 (Tank Man), Azzarella re-creates the scene from Tianan-
men Square, originally photographed by Associated Press photographer Jeff 
Widener. In Widener’s image, the man is face-to-face with several Type 59 
tanks during the Tiananmen Square protests of 1989. However, in Azzarella’s 
image, the tanks are removed, and the man is left isolated in the middle of the 
street, seemingly out of the way of danger (FIGURE 7.1). Similarly, Untitled #7 
(16mm) is an 11-second loop showing 
President John F. Kennedy driv-
ing near the grassy knoll but never 
experiencing the fatal bullet wound. 
The footage of JFK riding in the car is 
haunting for contemporary viewers 
who know where the drive leads, 
even though it never quite gets there 
[2]. These examples of revision and 
manipulation aren’t meant to hoax 
or deceive the viewer (after all, we 
know what the artist is up to), but 
the strategies for image manipula-
tion are the same as those used to 
create a photographic hoax, which 
you’ll do in Exercises 4 and 5.

REFERENCE [2]  See Josh 
Azzarella’s videos on his 
website: www.joshazzarella.
com. 

FIGURE 7.1  Josh Azzarella, Untitled #15 (Tank Man). This image is a single 
frame in Azzarella’s video. Image appears courtesy of the artist.
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WHAT YOU’LL NEED
Download the following source materials to com-
plete the exercises in this chapter:

✔✔ The chapter07-workfiles.zip file which includes 
repair-start.psd and hoax-start.psd in the 
chapter07-start folder.

✔✔ Alternatively, you can download the two 
photographs you’ll need for this chapter from 
their source repositories online (see the sidebar 
Downloads). Save them in a folder named 
chapter07.

You’ll benefit from the ability to see changes in 
values and textures across all areas of the image.

WHAT YOU’LL MAKE
In the exercises in this chapter, you’ll repair 
a dusty portrait of JFK (FIGURE 7.2) and create 
an “extra finger” mummy hoax (FIGURE 7.3). The 
repairs and hoax share the aesthetic quality of 
verisimilitude—they deceive the viewer into believ-
ing your manipulated version of reality.

FIGURE 7.2  A portrait of President John F. Kennedy before and after digital repairs.

Image credits for the source photographs President John F. Kennedy, head-and-shoulders portrait, facing front (1961) appears 
and is used in this chapter courtesy of the Library of Congress [LC-USZ62-117124]. Hand of Guanajuato Mummy appears and is 
used in this chapter courtesy of Tomás Castelazo.

FIGURE 7.3  A mummy hoax includes an extra finger.
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DOWNLOADS: HIGH-RESOLUTION IMAGES FROM THE LIBRARY 
OF CONGRESS WEBSITE AND WIKIMEDIA COMMONS

1.	 The photograph of President John F. Kennedy is available on the Library of Con-
gress website—search for image LC-DIG-ppmsca-38698 on loc.gov. Beneath the 
thumbnail of the image on the left side of the page, you’ll see a link to download 
the 32.1 MB TIFF file of the image. This is the largest image available, and it’s the 
one you should download, because you can always scale down but you can’t add 
pixels. 32 MB is a large black-and-white file! It’s approximately 17 by 21 inches at 
300 DPI. I downloaded this image and then scaled it down to 9 inches vertically at 
300 DPI for the repair-start.psd file that I’ve included in the files on the compan-
ion site. If you want your brush sizes to match mine during the exercises, do the 
same or use the files on the companion site.

2.	 The file Placid death.jpg is available from Wikimedia Commons. The highest 
resolution file can be downloaded by clicking the “Original file” link that appears 
beneath the image on the file page. If you click the image itself to open it in a 
separate window, you’ll view the largest image. Then you can right-click the 
image (Control-click on older Macs) to open a contextual menu from which you 
choose Save Image As to download the image. Download the original file and save 
it as hoax-start.jpg.

EXERCISE 

1 REMOVE DUST AND HEAL JFK’S  
BLEMISHES WITH THE DEVELOP PANEL  

IN ADOBE LIGHTROOM CLASSIC
There are multiple ways to repair skin tones with digital tools. In this exercise, 
you will use the Spot Removal tool in Lightroom Classic. In Exercise 2, you will 
use similar tools in Photoshop.

PUBLIC DOMAIN AND CREATIVE COMMONS LICENSED IMAGES

To begin the exercises in this chapter, you’ll use two images that are, for different reasons, free to you. The portrait 
of JFK has two listings that let me judge that the image is in the public domain:

•	 Rights Advisory: No known restrictions on publication.

•	 Notes: U.S. Navy photo.

Because there are no known restrictions and this was a U.S. Navy photo (and government media is typically in the 
public domain), I have assessed that the image is fair to use. Also notice that the Library of Congress includes the 
following in red letters: “Rights assessment is your responsibility.”

The mummy image is licensed under the Creative Commons Attribution-Share Alike 2.5 Generic license. Because 
the image has a Share-Alike component (and this book is not licensed with a CC-BY-SA license, as it would be writ-
ten in shorthand), I contacted the author for permission to use the image.
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1.	 Launch Adobe Lightroom Classic, and import the repair-start.psd file to 
your Lightroom library. Make sure the Add option is active before you click 
the Import button.

2.	 Double-click the image preview, and change the module from Library to 
Develop by clicking the Develop button in the Module Picker at the top of 
the screen (FIGURE 7.4).

3.	 The tonal range and contrast in this photograph do not appear to need 
significant adjustments, however digital artists often touch-up portraits 
to soften wrinkles, even skin tones, and remove blemishes. Zoom in on 
JFK’s face either with the mouse wheel (or touchpad) or by pressing the 
Command-+/Ctrl-+ keys. Inspect the surface of the skin, looking for places 
where wrinkles appear to be especially deep as a result of shadow/high-
light contrast. Also look for spots or blemishes. Load the Spot Removal tool 
from the set of buttons beneath the Histogram (FIGURE 7.5).

See Chapter 6 Exercise 5 
to learn about importing 
images to Lightroom 
Classic.

FIGURE 7.4  Open the 
repair-start.psd file in the 
Adobe Lightroom Classic 
Develop module.

FIGURE 7.5  Load the Spot 
Removal tool in Lightroom 
Classic.
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4.	 Notice the Brush options that appear beneath the Spot Removal tool when 
this tool is loaded. This tool operates like a brush: It has controls for its 
size, feather (that is, edge sharpness), and opacity. You can work with this 
tool in Clone or Heal mode. If you are cloning, you need to sample a source 
to clone from before you begin brushing with the tool. If you are healing, 
simply click with the brush and Lightroom Classic will work its magic 
by automatically selecting a source based on a similar area of the image 
according to its tone and texture. Be sure that Heal mode is selected as you 
will work with the brush in this mode in the next steps (FIGURE 7.6).

5.	 Practice zooming in and out and moving the image around in the appli-
cation window. I use hot keys for all of this, as when I use my trackpad 
or mouse wheel (or a touchpad), I often end up resizing the brush by 
accident. I use Command-+ and Command-– to zoom (Ctrl-+ and Ctrl-– for 
Windows users), and I press the Spacebar to engage the Hand tool, which 
I use to move the surface of the image around. When I am repairing or 
modifying the image data, like you are about to do in this step, I like to 
see that information in detail, which means that less of the image appears 
on screen at once. You will quickly develop kinetic memory in your hands 
to change the zoom level and location of the image on the screen without 
having to look down. While the image of JFK’s face fills the screen from his 
forehead to his lips, look for a dark spot on his cheekbone (his left, your 
right side). Move the Spot Removal tool so the brush hovers over this area. 
Is the brush too small, too large, or just the right size for repairing this 
dark spot? The circular brush tip should be just a little larger than the spot. 
Mine happened to be exactly the same size as the spot, so I increased my 
brush by about 15 pixels. I did not use the Size slider in the Brush panel, 
instead I used the key commands. Press the Left Bracket ([) key to decrease 
the size of the brush and the Right Bracket (]) key to increase its size. When 
the brush size is set correctly, click the dark spot (FIGURE 7.7).

FIGURE 7.6  Set the Spot 
Removal brush to Heal.

FIGURE 7.7  Click the Spot Removal tool on a dark spot or blemish to replace it with similar tones selected from another part of 
the image. Use a brush size that covers the spot.

HAND TOOL  Use the 
Hand tool to move the 
image around the screen 
while you’re zoomed in. 
You’re not moving any 
part of the image file; 
you’re simply changing 
your view when you use 
the Hand tool. Access 
this tool by pressing the 
spacebar. This tool is 
useful in many Adobe 
applications, including 
Lightroom Classic, Pho-
toshop, and Illustrator.

ZOOM TOOL  You can 
easily access the Zoom 
tool while working 
with most other Adobe 
Creative Cloud applica-
tions by pressing the 
Command/Ctrl keys with 
the Equal or Minus key. (I 
always think of zooming 
in as Command-+ even 
though the Shift key is 
not involved).
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6.	 Did the spot disappear? Are you happy with the tonal adjustments 
Lightroom Classic, selected for you? You can still edit this spot because 
Lightroom edits are non-destructive. All of the information in the original 
image is preserved, and modifications made in the Develop panel are 
saved separately. In addition to your repair, you should see two circles con-
nected by a thin arrow on top of the image. One circle shows the location 
Lightroom chose to sample repair information for the dark spot. The arrow 
grows from this circle to another one. At the end of the arrowhead is the 
second circle, where you made the repair. Notice how the Spot Removal 
tool’s appearance changes depending on where you place the pointer on 
the image. When you hover the tool over either of the circles, it changes to 
a hand pointer. In all other parts of the image, the circular brush remains 
active for the tool, so you can repair or remove additional spots. Click the 
circle over the dark spot you just removed. Modify the brush settings; they 
are still active, even after you used them. Change the Size, Feather, and 
Opacity settings by dragging the sliders all the way to the left and right 
extremes, just to see how these adjustments control the results of your 
repair, and then use your best judgment to set them properly. I ended up 
leaving my settings as seen in the third part of FIGURE 7.8.

7.	 You can also move the circle that accounts for the sampled part of the 
image to see different results from the Spot Removal tool. Use the Spot 
Removal tool, again with the brush set to Heal to drag a line over the 
darker wrinkle across the middle of JFK’s forehead (FIGURE 7.9). You’ll 
modify the results in the next step.

FIGURE 7.8  When the brush is too large (above) or too small (top 
right), your image edits will draw more attention to the spots you 
are trying to hide. When the brush is the right size (right), you 
should consider adjusting the feather and opacity until the new 
image information fools the eye.
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8.	 Wrinkles should not be completely erased. If your Opacity was set to 100 
you will have replaced them with smoother skin and you should adjust the 
opacity downwards. If your brush was too large, you may have sampled 
the other wrinkles across his forehead, which could have left you in a bit 
of a mess. Now you should modify the brush options while the area you 
just painted across is active. (If you deselected it, click the circle attached 
to the area where you made an adjustment.) I changed the Opacity value 
to 40, then I moved the sample source to a lower part of the forehead by 
dragging the circle at the blunt end of the arrow (FIGURE 7.10).

FEATHER  You will find a numeric field or slider to control the Feather value in various 
parts of such Creative Cloud applications as Lightroom Classic and Photoshop. In all 
cases, this refers to how sharp an edge should appear. When you are using the Spot 
Removal in combination with Heal mode or the Healing Brush in Photoshop, you will 
probably choose a small number for the Feather option because you do not want the 
brush edges to be visible. When you are cloning, however, you may want to start with no 
amount of feathering so that you clone pixel information precisely. Then you may return 
to the clone area with some amount of feather applied to the brush to blend the results.

FIGURE 7.9  The Spot 
Removal tool can be drawn 
in a line over large areas 
for repair. Be extra attentive 
to the Opacity and Feather 
settings in these cases. 

FIGURE 7.10  The location of the sample source can be adjusted once you have made a repair.
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FIGURE 7.11  When the Tool Overlay option is set to Always, it is 
easy to see all of the locations where repairs have been made.

FIGURE 7.12  Changing the Tool Overlay option to Never allows 
you to see results of the repairs you made without being dis-
tracted by the interface.

9.	 Continue working with the Spot Removal tool set to Heal on the entire 
image, including the dust in the negative space around JFK’s head and the 
bags beneath his eyes. Choose the Tool Overlay option Always to see all 
of the locations where you have modified the image (FIGURE 7.11); choose 
Never to see the results of your work (FIGURE 7.12).

10.	When you are finished, click the Done button in the lower-right side of the 
image window (FIGURE 7.13).

11.	Choose File > Export to save a file with all of your adjustments. In the 
Export One File dialog box, choose Export To: Hard Drive from the first 
menu. In the Export Location section of the dialog box, choose Same 
Folder As Original Photo from the Export To: menu, and in the File Nam-
ing section, choose Filename-Sequence from the Rename To: menu. You 
should see a preview of the file name, repair-start-1.jpg (FIGURE 7.14). Click 
the Export button.

FIGURE 7.13  Finish your 
repairs, and click the Done 
button.

TOOL OVERLAY  In the 
Toolbar at the bottom 
of the image is the Tool 
Overlay menu. This lets 
you control the visibility 
of tools, depending on 
what you are working on. 
If you leave it on Always, 
you will always be able 
to see the circles created 
by the Spot Removal 
tool. This can be help-
ful for being able to 
select them and modify 
them. At other times, 
you may want to change 
the menu to Selected or 
Never, because it can be 
difficult to see the results 
of the tool in the context 
of surrounding pixels 
when a white trace line 
interrupts your view. 
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12.	Quit Lightroom Classic as you will work in Photoshop next.

EXERCISE 

2 �JFK’S EYES: TONAL REPAIRS  
WITH DODGE AND BURN

Now you’ll focus on repairing the eye area. Because you’ve already done a 
once-over with the Spot Healing Brush tool for dust, scratches, and major 
blemish repairs, you’ll do this additional, localized work on a new layer in 
Adobe Photoshop. In this exercise, you’ll modify a copy of JFK’s eyes with 
the Dodge and Burn tools. If you’ve never printed a negative in the darkroom, 
the analogy between this tool and common darkroom practices might not be 
intuitive. Dodging reduces the amount of light a print is exposed to during 
image processing in a darkroom, while burning adds additional exposure time 
(remember that the more light that hits a patch of photographic paper, the 
darker it becomes). Sometimes a negative needs a full exposure in all areas 
except for one (for instance, around JFK’s eyes—beneath his eyes he had dark 
rings and his eyebrows are so light they barely register). Photographers dodge 
prints during the image processing by blocking exposure light on a certain 
area (or areas) of the paper (to keep them lighter) or by blocking nearly the 
entire exposure with the exception of a small area in order to “burn” it in (and 
darken it). In turn, these small portions of the print receive less or more light 
in comparison to the rest of the projected imagery. When burning an area of 
the sensitized paper during an exposure to light in a black-and-white wet lab, 
for instance, a common exposure time for the adjustment might be about 5 to 
10 percent of the total exposure. So, in Photoshop, you might start with the 

FIGURE 7.14  Export the file 
containing image repairs to 
the same folder as the orig-
inal folder with a sequence 
number.
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Exposure value set at 5% or 10% in the Burn tool options. Of course, this value 
varies from negative to negative (or file to file), so it’s common to make a best 
guess when using this tool in combination with Command-Z/Ctrl-Z.

1.	 In Adobe Photoshop, open repair-start-1.jpg, which you just exported from 
Lightroom Classic. If you skipped this first exercise, open repair-start-1.jpg 
from the chapter07-start folder in chapter07-workfiles.zip available on the 
companion website.

2.	 Select the Lasso tool from the Tools panel (FIGURE 7.15). This tool lets you 
make a free-form selection around any part of the image. It’s not a good 
tool to use when you need to perform a precise selection, but it’s perfect 
for quickly isolating a general area of the image.

3.	 Draw a loose circle all the way around the left eye area, including a bit 
above the eyebrows. Be sure to begin and end the selection at the same 
point so that Photoshop knows the complete area of the selection. You’ll 
see flickering dashed lines surrounding the selected area, often referred 
to as “marching ants.” Now you’ll add a selected area around the right 
eye to the current selection. Press and hold the Shift key while drawing a 
circular shape around the right eye area with the Lasso tool—the tiny plus 
sign near the bottom of the tool shows that you’re adding to the current 
selection. You should have two sets of marching ants on the image, one 
surrounding each eye (FIGURE 7.16).

4.	 Copy the selected eye area and paste it using the keyboard shortcuts 

Command-C/Ctrl-C then Command-V/Ctrl-V. In the Layers panel, rename 
the new layer eyes. Choose File > Save As to save the PSD file to your hard 
drive. I named mine repair-end.psd and put it in my results folder.

WORKSPACE  Choose 
Window > Workspace > 
Photography for the 
remaining exercises in 
Photoshop.

KEYBOARD SHORTCUTS   
When copying and past-
ing from one layer to 
another, an alternative to 
Command-C/Ctrl-C and 
Command-V/Ctrl-V is to 
use the single command 
Command-J/Ctrl-J to 

“float” the selected area to 
a new layer.

FIGURE 7.16  Start and end 
the selection with the Lasso 
tool at the same location 
in the image. Press and 
hold the Shift key to add 
to an active selection. The 
“marching ants” show a 
selection around the eye 
area.

FIGURE 7.15  The Lasso tool 
is grouped with other selec-
tion tools.

156  FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD



SCREENCAST 7-1  ADDING AND DELETING WITHIN SELECTIONS

You can add to any selection using one of the Photoshop selection tools by press-
ing the Shift key. If you want to add extra area to an existing selection, you’ll have 
to begin the “new” part of the selected area from within the existing selection. If you 
want to subtract part of an existing selection, press and hold the Option/Alt key while 
starting the “deleted” area of the selection from outside the existing selection. This is 
much more easily understood by seeing it demonstrated than by reading text. For a 
demonstration, view the screencast for this chapter.

All screencasts are available on the companion website, www.digitalart-design.com or on 
the Vimeo playlist, bit.ly/foundations-demos.

5.	 The bags beneath his eyes were too dark before you lightened them with 
the Spot Removal tool in Lightroom Classic. In opposition to this, his eye-
brows (especially his left brow) are so light they barely register. Because 
you already corrected for the skin tones under his eyes in Lightroom, load 
the Burn tool to darken the brows (FIGURE 7.17).

6.	 Glance at the Layers panel. Nothing should have changed there; you 
should be working on the eyes layer. (Click it to make it active if you 
noticed that another layer is active.) Always look at the tool options, espe-
cially before using a new tool. There are many options for the Burn tool. 
For now, notice the Brush Preset picker menu, the Range menu (choose 
Highlights), and Exposure control (set that to 10%). There are other 
options, too, including the option to enable airbrush style build-up, the 
Protect Tones checkbox, and an icon that allows the pressure to determine 
brush size when using a stylus pen. Open the Brush Preset picker menu, 
and make sure that the Hardness level is set to zero, as you’ll want your 
brush to have a soft edge to allow the burning results to feather or blend 
into the image. Place your pointer over the eyebrow and use key com-
mands to adjust its size so it covers the eyebrows where they are largest 
(Left Bracket key or Right Bracket key, just like in Lightroom). Now you 
need to estimate a reasonable exposure value. The general rule is that you 
can always brush these tools over an area more than once, so it’s better 
to err on the side of a lower value. Play with the exposure value (I ended 
up using 10%), and make a quick brushstroke over JFK’s left eyebrow 
to darken it (FIGURE 7.18). Zoom out to 100% to evaluate your results. I 
brushed twice over the left brow and once towards the end of the brow on 
the right side of the image. The modification should not be extreme. Your 
modification should be believable!

Keep a copy of the 
original file in the Layers 
panel when working on 
repairs. Naming your 
layers as you work will 
keep the panel organized 
and help you work effi-
ciently as the size of the 
list increases.

FIGURE 7.17  The Burn tool 
is grouped with the Dodge 
and Sponge tools. These 
tools alter the tonal values 
and intensity of the hue in 
an image.

POINTER IMAGE  If 
you don’t see a circle 
representing the size of 
the brush in Photoshop, 
check your Photoshop 
preferences. The brush’s 
appearance is set in 
Photoshop > Prefer-
ences > Cursors/Edit > 
Preferences > Cursors. 
Choose Normal Brush 
Tip. Also, make sure 
your Caps Lock key is 
not depressed. Engaging 
Caps Lock will change 
the pointer image to a 
cross-hair.
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COPYING IMAGE PARTS

Be extra attentive to the Layers panel when copying selected parts of an image. It’s 
common for new users to attempt to copy part of the image that they can see, but 
that isn’t actually on the selected layer. If you do this, you might get an error message 
stating “Could not complete the copy command because the selected area is empty.” 
This happens to everyone at some point during image manipulations. Simply click OK 
to exit the warning dialog, and then activate the appropriate layer before attempting 
to copy again.

FIGURE 7.18  Touch up the 
brow area with the Burn 
tool. Adjust your settings so 
you need to brush over this 
area of the image only once 
or twice.

Why not use the Spot 
Healing Brush tool here? 
You could work with the 
Spot Healing Brush tool 
to correct the eyebrows, 
but the trouble here is 
not the pixel informa-
tion, just the value of the 
highlight tone. In this 
situation, correcting the 
tones by burning and 
dodging will maintain 
the integrity of the image.

HISTORY IS FULL OF REVISIONS

Repairs will inevitably lead you to over-click with tools such as the Healing Brush or the Dodge and Burn tools 
in the Photoshop file. It’s easy to become click-crazy in the process. Familiarize yourself with the History panel, 
as you’ll come to rely on this handy Photoshop archive. There are three things you need to know about using the 
History panel:

•	 Access the History panel from Windows > History or the History icon in the column of panels on the right side 
of the Application window.

•	 By default, Photoshop may save only 20 or 50 of your previous clicks or steps. You’ll want to increase this when 
doing repair work. Choose Photoshop > Preferences > Performance/Edit > Preferences > Performance. On the 
right side of the dialog box, enter 99 in the History States field. The more clicks or previous states you save, the 
more RAM you’ll use. If your computer is slow or lacking RAM, you may want to skip this step.

•	 To go back a step or two, or five, click once on the name of each of the previous steps in the History panel until 
your file appears in the state at which you want to begin working anew. There’s nothing else you need to click. 
Simply begin working again, and the History panel will create new steps, overwriting the dimmed step or steps 
that you’re leaving out of your process.

158  FOUNDATIONS OF DIGITAL ART AND DESIGN WITH ADOBE CREATIVE CLOUD



7.	 Review your modifications at actual size by using the keyboard short-
cut Command-1/Ctrl-1. Click the eyeball icon next to the eyes layer in 
the Layers panel to hide and show the layer (FIGURE 7.19). If you have 
gone too far, you can reverse your way back through your actions using 
Command‑Z/Ctrl-Z or the History panel (see the sidebar). When you are 
finished adjusting the eye area, save your work and close the file.

FIGURE 7.19  Making the 
eyes layer alternately 
invisible (top) and visible 
(bottom) helps preview 
repairs. You can easily see 
your repairs by clicking 
the Eyeball icon on and off 
in the Layers panel.
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EXERCISE 

3 �IT’S A HOAX! ADDING AN EXTRA  
MUMMY FINGER

In this exercise, you’ll add an extra mummy finger using the Clone Stamp tool. 
This tool functions similarly to the Spot Repair tool in Lightroom Classic and 
the Healing Brush tool in Photoshop, but you’re responsible for selecting the 
location of the source area before making repairs. You’ll work with a hard-
edged and soft-edged brush in this exercise. In the next exercise, you’ll clean 
your work with a layer mask.

1.	 Open hoax-start.psd in Photoshop. Continue to work in the Photography 
workspace.

2.	 In the Layers panel, click the Create A New Layer icon. Unless you clicked 
the icon more than once, the layer’s default name is Layer 1. Rename 
it finger. You now have an empty layer named finger above the locked 
Background layer in the Layers panel.

3.	 Select the Clone Stamp tool from the Tools panel (FIGURE 7.20). View the 
Options bar. I set my brush to 250 pixels and changed the Hardness value 
to 85%. Because you’ll be copying pixels with this tool, you’ll want to use 
a brush that isn’t too soft. The soft edges often blur the pixel information, 
which you want to keep sharp, at least during the copying portion of this 
process. Keep the Mode set to Normal, leave the Opacity and Flow at 100%, 
check the Aligned box, and set the Sample menu to All Layers (FIGURE 7.21). 
Remember, you’ll first sample with this tool and then clone. If you check 
the Align box, you’re telling Photoshop to keep the sample area aligned 
with the cloning area. You’ll see that it makes sense to keep the source and 
clone aligned. 

FIGURE 7.20  The Clone 
Stamp tool is grouped with 
the Pattern Stamp tool in 
the Tools panel.

FIGURE 7.21  Brush settings are in the Options bar. The brush hardness is set to 85%. You can 
also see the other tool options set for cloning in this exercise.
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4.	 Zoom in using the same key commands as in other Adobe 
applications, such as Command-+/Ctrl-+. Make sure the 
finger layer is active; this is where you want to place your 
cloned finger. Place the Clone Stamp tool (which basically 
functions as a brush with an extra sampling step) on top 
of the last knuckle. Press the Option/Alt key, and click just 
once in this location (FIGURE 7.22). Don’t drag the mouse. 
You just told Photoshop that this is the area that you want 
to sample as you clone the new finger, and because the 
option for Sample is set to All Layers, you are allowed to 
sample from whatever parts of the image this brush covers, 
on any of the layers. There is nothing to sample on the 
finger layer, so the Clone Stamp tool will sample from the 
mummy finger on the Background layer. 

5.	 Move the mouse to the right of the last knuckle and down 
a little bit to align it with a plausible location for a new 
knuckle (FIGURE 7.23). The Clone Stamp tool provides a 
preview of what the cloned image will look like in your 
composition so you can get the alignment just right before 
committing to a click. Click and drag downward, trac-
ing the finger, until you reach the end of the fingernail 
(FIGURE 7.24). Save the file as hoax-end.psd, which you’ll 
update at the end of the next exercise.

Congratulations! You just added a sixth finger to a 
mummy. In the next exercise, you’ll clean the cloned image 
data to make the new finger blend with the rest of the 
composition.

FIGURE 7.22  Sample from 
the mummy’s knuckle with 
the Clone Stamp tool. Check 
to make sure the finger 
layer is active.

FIGURE 7.24  The new finger in position. The 
brush hardness ensures that pixels are sam-
pled accurately.

FIGURE 7.23  Paint a new finger using the Clone 
Stamp tool aligned next to the sampled finger.
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EXERCISE 

4 SOFTENING CLONED EDGES

Fingers don’t stay the same size from the knuckle to the nail, so because 
there are extra parts of the cloned finger that obstruct the view of the original 
composition, the viewer can tell that the image has been manipulated. In this 
exercise, you’ll use a layer mask to hide extra parts surrounding the cloned 
finger. Consider this exercise to be a brief introduction to the layer mask. You’ll 
learn more about layer masks in the next chapter.

1.	 In the Layers panel, activate the finger layer and then click the Add Layer 
Mask button (FIGURE 7.25). You’ll see a new icon in the Layers panel: a white 
square next to the layer icon of the finger.

2.	 The layer mask is used to hide or show parts of a 
layer. Because the finger layer contains only the 
extra, cloned finger, the mask will affect only this 
image data. You could work with the Eraser tool 
to delete image data, but instead it is preferable 
to work non-destructively, to simply hide (rather 
than delete) pixels. Layer masks operate in white 
(show the layer content), black (hide the layer 
content), and shades of gray (partially hidden). 
Press B to select the Brush tool (or locate it nested 
with the Pencil tool in the Tools panel), and press 
X to load black into the foreground color chip 
(FIGURE 7.26).

3.	 View the Brush tool options. Set the Hardness 
value to 0, as you’ll want to use a soft-edged 
brush. Leave the Mode set to Normal and Opacity 
and Flow at 100%. You will adjust the size using 
the keyboard.

4.	 Before using the Brush tool, make sure that the 
mask is active in the Layers panel. You can click 
once on the layer content thumbnail or on the 
mask icon. Notice that whichever is activated is 
framed with white edges around its icon and near the file name (at the top 
of the document window) additional information confirms your location 
in the file’s organizational structure (FIGURE 7.27). When you’re sure that 
the mask is active, you are ready to set the size of the brush and then paint 
black around the edges of the finger where you want to hide the extra 
image details (FIGURE 7.28).

KEYBOARD SHORTCUT   
Because you’ll always 
work with white and 
black on Photoshop 
layer masks, you should 
remember that X is the 
hot key for swapping the 
foreground and back-
ground colors.

FIGURE 7.25  While the finger 
layer is active, click the Add 
Layer Mask icon to create a 
mask specific to this layer.

FIGURE 7.26  The Brush 
tool is selected with black 
loaded into the fore-
ground color chip.
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5.	 Notice that the layer mask now contains an abstract black painting on its 
white background. Option-click/Alt-click the layer mask icon in the Layers 
panel to show just the mask in your composition (FIGURE 7.29). The black 
areas of the composition are hidden. The white areas are revealed. Look 
for gaps between the black and white areas. You may want to review those 
parts of the composition and add more black or white paint to fill in the 
gaps. This is an easy way to clean the mask because you can easily see 
how the image details are being treated. Option-click/Alt-click the mask 
icon in the Layers panel again to resume the normal working mode and 
continue to modify the layer mask (FIGURE 7.30).

FIGURE 7.28  Extra image details are hidden by painting the mask black in those areas. Here you can see the black brushstroke 
on the layer mask icon.

FIGURE 7.27  Click the layer content icon or the layer mask icon to make adjustments to the layer or its mask. Notice how the 
information near the name of the file updates depending on which part of the file is activated.
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6.	 Remember to view the document at actual size and then save the file.

LAB CHALLENGE

Create a hoax! Modify a current news story by using the repair and clone tools 
you learned about in this chapter on a fictitious news image. In news photog-
raphy, the caption is important, too. Don’t forget to write a caption to accom-
pany your newsworthy image.

FIGURE 7.29  A view of the 
finger layer mask. The white 
areas are visible in the 
document. The black areas 
are hidden from view (or 
masked). Any gaps would 
be filled in with the Brush 
tool using black.

FIGURE 7.30  The mummy 
finger hoax is complete and 
visible in normal editing 
mode.
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Schad, Christian, 138
screen resolution, 99–100, 198
screencasts, xii

on adding/deleting within 
selections, 157

on clipping masks, 247
on collage process, 193
on colorizing B&W photos, 132
on editing digital video, 287
on grid use, 270
on horizon line effect, 39
on Info panel, 104
on keyframes, 303
on modifying paths, 58
on pattern brush, 19
on Premiere Pro projects, 283
on renaming files in Bridge, 88
on tracing with the Pen tool, 172

scrubbing video, 286

connecting the screens in, 
207–210

designing the elements of, 
204–206

explanatory overview of, 195–197
testing and sharing, 211

PSD files, 102
public domain images, 143, 149, 187
punk movement, 141

Q
Quick Develop panel, 133–134
Quick Selection tool, 190

R
Ray, Man, 93, 138
Rectangle tool, 34, 242
Rectangular Marquee tool, 103, 

119, 183
redistributing pixels, 92, 97–98
Reflect tool, 58–59, 244
Rejlander, Oscar Gustav, 138
relinking images, 231
renaming. See naming/renaming
repairing photos

blemish and wrinkle removal, 
149–155

Clone Stamp tool for, 160–161
Photoshop tools overview 

for, 146
softening cloned edges, 162–164
tonal repairs, 155–159

resampling pixels, 92–93, 98, 99–100
resetting the workspace, 13, 30
resizing. See sizing/resizing
resolution

print, 97–98
prototype, 199
redistributing pixels for, 92, 

97–98
resampling pixels for, 92–93, 

99–100
screen, 99–100, 198

Responsive Resize option, 200
revision practices, 309–327

examples illustrating, 311–327
open communication related 

to, 311
overview and manifesto on, 

309–310, 327

photography
color vs. B&W, 66
historical development of, 63
manipulation processes in, 

137–142
vector illustration vs., 64
zone system of, 65, 95–96, 103
See also digital photography

Photography workspace, 173
photomontage. See collages
Photoshop, 12

color correction in, 128–131
repairing photos in, 146, 155–159

Piana, Brian, 116
Picasso, Pablo, 144
pixels

bitmap images and, 12, 65
development of, 4, 6
redistributing, 92, 97–98
resampling, 92–93, 98, 99–100

pointillism, 5, 6
Polygon tool, 49
Polygonal Lasso tool, 119, 120
PPI (pixels per inch), 97, 99, 100
Practical Zone System for Film 

and Digital Photography, The 
(Johnson), 95, 96

Prägnanz, Law of, 250, 252, 300
Premiere Pro

Effect Controls panel, 293–294, 
295, 299–300

Source and Program panels, 
285, 293

Timeline panel, 285, 289, 291
title safe area, 280
video playback shortcuts, 286
workspace navigation, 283–287
See also digital video

primary colors, 114, 115
printing

combination, 138
paper size for, 258–259
resolution for, 97–98
trim marks for, 61, 272–273

Program panel, 285, 286
Project panel, 283, 284, 293
Properties panel, 108, 109
Prototype mode, Adobe XD, 207
prototypes

artboard setup for, 200–203
articulating the design of, 199
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overflow indicator for, 268, 269
spacing considerations for, 

255–256
widows and orphans in, 257
See also typography

text boxes, 227
adding, 232–233
linking, 268
resizing, 268, 269
rotating, 237

text frames, 227
Thinking with Type (Lupton), 216, 

217, 252
third-party images, xiii
Thompson, Bill, 311, 312, 315–316
Thompson, Lauren, 76
Thomson, Jon, 68
time passage theme, 67–68, 90
timecode, 279, 284
timeline

adjusting clips in, 290–293
repositioning clips on, 289
video terminology for, 283

Timeline panel, 285, 289, 291
Tingley, Ashley, 77
title safe area, 280
Toews, Phoenix, 4
tonal range

color and, 113
modifying, 106–109
repairing, 155–159
values and, 93–95

Tool Overlay options, 154
tools, toggling between, 16
tracing images, 33, 172–176
tracking type

process of, 227, 228, 229
rhythm of text controlled by, 

255, 256
tracks, audio/video, 290, 302–303
transforming shapes, 125
transitions

prototype, 207–209
video, 305–306

transparency
locking, 125–126
of type, 237

triggers, prototype, 207, 209
trim marks on PDFs, 60–61, 272–273

sizing/resizing
brushes, 151, 189
text boxes, 268, 269
type, 234–236

Sketchpad, 6
Sky Is Falling, The (Demers), 318–320
Smart Guides, 48
Snap command, 107
Solomon, Lucy Hg, 320
Sontag, Susan, 139
Soucy, Kyle, 211
Source panel, 285, 293
Spiekermann, Erik, 224, 250, 311
Spot Healing Brush tool, 146, 158
Spot Removal tool, 150–154
stacking order

of layers, 31, 105
of paths, 50

Stamberg, Susan, 5
standing meetings, 317–318
Stark, Kio, 309
Starry Night, The (van Gogh), 10, 11
Stevens, Rachel, 4
storyboard planning, 315
Stowell, Davin, 197
straight paths, 46
Stroke icon, 16
strokes

lines as, 6
of shapes, 14, 16

stylistic consistency, 275
subtractive processes, 112
surrealism, 142
Sutherland, Ivan, 6
SWEAT collective, 195, 196
Swiss International Style, 249, 

252–253
symbolic signs, 46

T
Talbot, William Henry Fox, 137
Template button, 30
Terror, Diogo, 253
testing prototypes, 211
text

changing the color of, 269, 270
kerning, leading, and tracking, 

227–229

selection column, 35, 36
Selection tool, 15, 16, 33, 233
selections

adding/deleting within, 157
consistency of, 105
converting paths to, 180–181
copying/pasting, 103, 104, 

156, 158
features of tools for, 125
layer masks from, 181
making free-form, 156
marqueeing, 15
Pen tool for, 166–167
scaling, 121

sentences, assembling type into, 
253–257

sequences
building composite, 287–290
video terminology for, 283

serif typefaces, 219–220
serifs, letterform, 217
Seurat, Georges, 5, 6
shadows

adding beneath images, 192, 193
Drop Shadow effect, 241

Shape Builder tool, 52
shapes, 14

aligning, 49
combining, 50–53
copying, 17–18, 51, 52
distributing, 20–21
drawing, 15, 16
framing with, 242–244
modifying, 54–55
reflecting, 58–59
selecting, 15, 16
stroke and fill of, 14, 16
three basic, 43–44
transforming, 125

sharing
files, 27, 42
prototypes, 211

Shift key, 16
shutter speed, 70, 77
shutter speed priority mode, 80
Signac, Paul, 5
signs and logos, 46
similarity, law of, 276
Simon, Scott, 310
simultaneous contrast, 117, 123–126
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web resources, xi–xii
Wegman, William, 281
Wertheimer, Max, 250
white balance settings, 75
Widener, Jeff, 147
widows, typographic, 257
Wikimedia Commons, 143, 149
Willows, Simon, 144
Windows platform, xi
Wolcott, Alexander, 137
Wong, Wucius, viii
work files, xi
workspace

collage, 170–172
Essentials Classic, 29, 47
Essentials (Default), 80
Output, 88
Photography, 173
Premiere Pro, 283–287
resetting, 13, 30

wrinkle removal, 152–153

X
XD program. See Adobe XD
x-height of letters, 217

Z
Zellen, Jody, 279
zone system

analyzing photos using, 101–106
explanation of, 65, 95–96, 103

Zoom tool, 53, 120, 151
zooming in/out, 120

U
Undo command, 173
units of measurement, 14
unlocking

guides, 48, 267
images, 34

user flow diagram, 199
user interface (UI)

designs, 142
kits, 203

V
values

contrasting, 38–41
histogram for reading, 93
zone system of, 95–96

Van Deusen, Thomas, 75
van Gogh, Vincent, 10, 11, 114
Varis, Lee, 101
vector graphics, 12, 64
verisimilitude, 144
video. See digital video
video tutorials. See screencasts
viewfinder vs. LCD screen, 72–73
viewport resolution, 198
Villareal, Leo, 2, 5, 10
virtual leading, 261–266

creating your own, 261–264
exercise on using, 264–266

visibility, issue of, 59
Visual Communication (Lester), 275

W
Warhol, Andy, 144
Wark, McKenzie, 139, 140
warm vs. cool hues, 117

Tschichold, Jan, 253
Type and Image (Meggs), 221
Type Primer, A (Kane), 218
Type tool, 227

entering headlines with, 259
selecting text with, 232, 234
text boxes drawn with, 232, 233

typefaces
families of, 221
serif vs. sans serif, 219–220
See also fonts

Typographie (Ruder), 254
typography

alignment in, 254–255
classes of type in, 218–219
contrast and rhythm in,  

224–226, 255
grid used in, 221, 249, 259–261, 

266–271
guide placement for, 259–261, 

266–270
Illustrator vs. InDesign, 222
images related to, 221, 226, 

239–242
kerning in, 227–228, 229, 235–236, 

239, 255
leading in, 227, 228, 238, 255, 256
letterforms in, 216–220
line length in, 253–254
overview of, 215–216
resizing type in, 234–236
resources about, 216
sentences and paragraphs in, 

253–257
Swiss International Style of, 249, 

252–253
tracking in, 227, 228, 229, 255, 256
video overlays using, 279, 280, 

297–299, 302–303
virtual leading in, 261–266
widows and orphans in, 257

Tzara, Tristan, 139
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